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GS5606 AutoCAD Map GIS Source Drawings and Vault 

Class Handout 

Updated 28th November, 2014 

Short Class Description 

Maximising the use of AutoCAD Map source drawings in a multi-user CAD environment, with 
desktop and mobile CAD user. 

Background Business Needs @ SA Power Networks 

AutoCAD Map 3D has a huge range of features and benefits to the users, and many demonstrated by 
Autodesk. 

Many of the features of the software are revealed by taking training classes and seeing software 
demonstrations, but none focus directly on integration with GIS systems and Drawing Management 
systems in an efficient and “fast-to-use” system for CAD users. 

The use of the “Source Drawings” feature of AutoCAD Map 3D, when implemented in a very 
structured manner, with a range of pre-set database fields directly sourced from GIS data, and 
presented to the CAD users in a native .dwg format, have huge advantages for the productivity of 
the AutoCAD Map users. 

Sa Power Networks has implemented the Autodesk AutoCAD Map3D software in an “easy-to-use” 
and efficient manner for the AutoCAD user community across our company. 

Network project officers (NPO’s), Surveyors, Street Lighting Designers, and CBD Facilities Records 
staff currently utilise the ESRI Decko read-only software to view GIS data, but cannot export this data 
in a useable CASD format. 

AutoCAD Map - Source Drawings Data Set – Features 

The AutoCAD Map “Source Drawings” data set distributed every 90 days to all CAD staff across our 
state on South Australia give the AutoCAD users the following features: 

• Geometry is delivered in the correct co-ordinate system and scale 

• Geometry is available from a single source 

• GIS reference data is automatically refreshed to the user’s CAD PC 

• All Cadastral data is provided to CAD users in native AutoCAD .dwg format suitable for 
AutoCAD Map and AutoCAD Civil3D 
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AutoCAD Map - Source Drawings Data Set – Features (cont’d) 

• Full CAD Layer support 

• Improved Parcel geometry with AutoCAD Closed Polylines 

• Reference Data (Bush Fire risk areas etc) available as native CAD Data 

• All Network AutoCAD  designs will be fully geo-referenced 

GIS Data for AutoCAD Map – Process 

The illustration below shows the manner in which the data is captured by an AutoCAD Map 3D user, 
to create a drawing using GIS data, from the “CAD-Source-Drawings” dataset, distributed to each 
CAD Workstation: 
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AutoCAD Map - Source Drawings Data Set - Asset Manager Zones & Data Sets 

The state of “South Australia” is broken up into a series of grid coordinate zones across from west to 
east, based on the “Map Grid of Australia” (MGA) system. 

Each geographical area is broken up for the purposes of our field staff, based out of field depots, and 
illustration below shows the zones across our large state of South Australia. 

Facts about “South Australia” 

South Australia covers some of the most arid parts of the continent, and is the fourth-largest of 
Australia's States and Territories, spreading across 983 482 km2. It is bordered to the north by the 
Northern Territory, to the east by Queensland, New South Wales and Victoria, to the west by 
Western Australia and along the south by the Great Australian Bight and the Southern Ocean. South 
Australia's coastline length is 5067 km, while its border length is 3185 km. 

South Australia spreads across 983,482 km2. Its land border is 3185 km and coastline 5067 km. 
South Australia is almost the same size as Egypt, one and a half times bigger than Texas, and five 
times the size of the UK. 

The size of these zones from west to east is approximately 1,850km. 
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AutoCAD Map – Workspace & Drive Alias 

To connect to the source drawing of any of these geographical zones, we setup what is known to 
AutoCAD Map 3D as a “Drive Alias”. 

When a “Drive Alias” has been setup the AutoCAD Map 3D software provides a fast and efficient way 
of accessing these drawings through an interfaces which is “fit-for-purpose” as shown below: 

 

Process Overview to Access GIS Land Base Data 

The following steps provide a basic overview to accessing Cadastral GIS land base reference data for 
use within AutoCAD: 

1. User creates a new Drawing based on a template 
E.g: “LD-Template.Dwt” 

2. The Drawing is saved into a Vault Drawing folder area, ready for Check-In 
 

3. Select a correct geo-referenced Coordinate System for the current project Drawing 
 

4. A GIS land base source drawing is now Attached from the master CAD Source Drawing 
Folders 
 

5. Run a Search function that is known as a Query of attached drawings, to  locate the land 
base geometry required 
 

6. Perform a Data Preview to review the area of data to be imported using the Quick View 
feature of AutoCAD Map 
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7. Extract the data from the source drawing into the current drawing using a Selection Window 

 
8.  Detach the source drawing from the current drawing, and continue with project design 

work 

CAD Source Drawing Folder Structure 

The CAD Source Drawing Folders is a folder structure of master data distributed to each CAD user, 
for access as needed. 

This is the complete data set of “GIS Reference Data for AutoCAD”. 

Most of the data is provided in AutoCAD .Dwg format, but other data sets for smart Road names, 
Topographical Data and other reference data are provided in other vector and raster formats, as 
described later in the course material. 

The basic cadastral source drawings that CAD Users will connect to will be provided in geographical 
areas based on SA Power Networks Asset Manager areas. 

The illustration below shows the complete folder structure of the “CAD Source Drawings” folders 
containing all the GIS reference data for AutoCAD access: 

 

The illustration shows the top level folder structure for the GIS reference data for AutoCAD, which is 
as follows: 

 “C:\CAD-Source-Drawings” 

The specific folder which is currently open is the following: 

“C:\CAD-Source-Drawings\LB-Source-Drawings\Elizabeth” 

This folder contains all the Cadastral GIS reference data for AutoCAD for the Elizabeth asset manager 
area. 
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Adelaide Data Set 

This data set is relatively large, and for ease of management within AutoCAD has been split into 
three areas, as follows: 

 Adelaide CBD including North Adelaide 
 (Adelaide City Council LGA) 
 Adelaide East 
 Adelaide West 

 

These areas are illustrated below: 
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Setting Up an AutoCAD Map 3D “Drive Alias” 

To access the Cadastral GIS reference data for AutoCAD use, we need to setup an interface within 
the AutoCAD Map software known as a Drive Alias. 

The purpose of a drive alias is to direct the AutoCAD software to search for GIS Cadastral Data in a 
specific folder area, completely separate from our Project working folder area. 

The following illustration shows a drive alias connection to the Elizabeth asset manager area master 
source drawings: 

 

In our AutoCAD Map 3D user training we show our users that to configure a drive alias to connect to 
the Elizabeth asset manager area master source drawings similar to that shown, for our subsequent 
exercises. 
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Exercise: Creating a Drive Alias for Source Drawing Access 

In this exercise we will configure a drive alias to connect to the Elizabeth asset manager area master 
source drawings, and then use this drive alias to access the cadastral data needed for a project in the 
Elizabeth Downs area. 

When creating a drive alias, we need to plan to designate the following two items: 

 Drive Alias Name 
 Drive Alias Path 

 

We will designate the following: 

Drive alias name: SD (Source Drawings) 

Drive alias path: C:\CAD-Source-Drawings\LB-Source-Drawings\Elizabeth 

1. Launch AutoCAD, and ensure the Planning and Analysis Workspace is selected as shown below: 
 

 

2. Ensure the Map Task Pane is visible, by selecting the View > Task Pane option as shown below: 
 

 

The Map Task Pane is a separate window within AutoCAD Map which will appear similar to the 
illustration below: 
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3. Select the Map Explorer Tab on the side of the Task Pane, to be able to access the Source Drawings 
functionality within AutoCAD Map. 
 

The Map Explorer Tab of the Task Pane should appear similar to that shown below: 
 

 

We will now use the Map task Pane to create our drive alias needed. 

4. Select the Data button, and select the Attach Source Drawings option as shown below: 
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When the attached source drawings option has been selected a dialog box similar to that shown 
below will be activated: 

 

At this point the software has not been configured to point to the C:\CAD-Source-Drawings\LB-
Source-Drawings\Elizabeth folder, as we have no drive alias settings. 

5. On the above dialog box named Select drawings to attach, select the Create / Edit Aliases button, 
which is illustrated below: 
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This will activate the Drive Alias Administration dialog box as shown below: 

 

Now provide the following: 

Drive Alias Name: SD 

Actual Path:  C:\CAD-Source-Drawings\LB-Source-Drawings\Elizabeth 

1. Enter SD for the drive alias name 
 

2. Then select the Browse option to browse to the C:\CAD-Source-Drawings\LB-Source-
Drawings\Elizabeth folder. 
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The Drive Alias Administration dialog box should now appear as shown below: 
 

 

3. Select the Add option to save this drive alias configuration. 
 

The Drive Alias Administration dialog box should now appear as shown below: 
 

 
 

4. The Drive Alias Administration dialog box can now be closed using the Close button, and is now ready 
for use. 
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Note: If you need to access GIS Cadastral data regularly from more than one folder area, such as: 

 Adelaide 

 Elizabeth 

 St Marys 

Suggested Drive Alias Names 

For consistency across CAD users, the following naming convention is suggested for the naming of 
AutoCAD Map drive aliases: 

 SDA (Source Drawings Adelaide) 

 SDE (Source Drawings Elizabeth) 

 SDSM (Source Drawings St Marys) 

 SDMB (Source Drawings Mt Barker) 

 SDSE (Source Drawings South East) 

 SDCN (Source Drawings Country North) 

 RD (Reference Drawings) 

 

Best 
Practice 

Creating Drive Alias Settings 

 

When creating drive alias settings, it is best practice to observe the following: 
 Keep the Drive Alias name as short as possible 
 Direct the path to the actual folder containing the relevant .dwg files, but to a folder above 

these files. This simplifies the display of the file names within the Map Explorer Task pane 

 

Setting the Correct Coordinate System 

The next important step is to establish the appropriate Coordinate System for the current project 
Drawing. 

This defines the correct geo-referencing of the drawing in relation to it’s true spatial location on the 
earth’s surface. 

Typical coordinate systems that will be used will be as follows: 

 MGA-52 (Zone 52) 
 MGA-53 (Zone 53) 
 MGA-54 (Zone 54) 

 

Of these three coordinate systems most ETSA Utilities projects will be conducted within the extents 
of the MGA-54 (Zone 54) coordinate system. 
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By default the MGA-54 coordinate system will be set within the Line Design CAD Drawing template, 
known as LD-Template.Dwt. 

To set another coordinate system, such as the MGA-53 (Zone 53) coordinate system, refer to Section 
6 of this training guide Drawing Coordinate Systems. 

Best 
Practice 

Setting Drawing Coordinate Systems 

 

Always set the Coordinate system correctly before attaching any source drawings for 
searching and Data extraction 

Be sure to do this for any MGA-53 or MGA-52 coordinate system drawings 

 

Exercise: Extract Using Rectangular Geographical Boundary 

We will now explore the option of Construct a Geographic boundary, and use this for the selection 
window. 

Firstly we will build a rectangle as a Polyline object, on a designated layer, and then use this 
rectangular Polyline as the pre-defined boundary window for our extraction process. 

In many cases a rectangular geographic boundary is displayed in the lower area of a drawing sheet, 
similar to the illustration below; 

 

We will now build a Project Geo-Boundary to define the geographical extents of the project in 
easting and northing coordinates as shown above. 

1. Create a New Drawing based on the LD-Template.dwt file 
 

2. Save the drawing as LD-100628702-AW-Rectangle.dwg 
 

3. Activate the layer for our rectangular Project Geo-Boundary called LD-Project-Geo-Boundary as 
shown below: 
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4. Draw a rectangular Polyline using the Rectangle command: 
 

 

 

5. When prompted for the coordinates of the rectangle, enter the following values: 
 For the lower left corner X=288573, Y=6158730 (288573,6158730) 
 For the upper right corner X=289423, Y=6160034 (289423,6160034) 
 

Note: 

Be careful to use the TAB Key to change between the X (easting) and Y (northing) values 
entered here. 
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This should build the rectangle appearing similar to the illustration below: 

 

This defines the boundary, which will be used in the next exercise 

 

6. Now save the drawing using File > Save ready for the next exercise  
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Exercise: Extracting Data using Polyline 

We will now perform an extraction of the data using this rectangular Polyline 

1. Ensure the drawing from the previous exercise is opened called LD-100628702-AW-Rectangle.dwg 
 

2. Attach the LB-Addressed-Property-Elizabeth-MGA54.dwg source drawing 
 

3. On the Map Task Pane select Data > Query Source Drawing 
 

4. Clear the current query, and select a new Query using the Location option: 
 

 

5. In the Location Condition window, select the Polyline option, and leave the other options set as 
Crossing and Polygon, and then select the Define function, which will prompt us to select an existing 
Polyline within the current project drawing. 
 

6. Select rectangle we created previously, and then select the Execute Query function on the Define 
Query of Attached Drawings dialog box, as shown below: 
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This should result in a data extraction similar to the illustration below: 

 

 

Note: Suburb boundaries visible of Blakeview and Smithfield, and adjacent Postcode boundaries for 5113, and 
5114 are also extracted, as the Polylines representing these “Cross” our Project rectangular  Geo-Boundary. 

 

Review the Properties of the Suburb and Postcode boundaries to familiarise yourself with their 
Layers and Object Properties. 
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Exercise: Detaching the Source Drawing 

To complete the process of extracting GIS reference data we would now Detach the source drawing 
from our current project drawing. 

The process of Detaching the source drawing is as follows: 

1. Within the Map Task pane, select the source drawing name, right-click and select Detach as shown 
below: 

 

Now that the connection between the source drawing, and current project drawing has been 
removed, we should save the drawing, before proceeding with further project design work. 

This completes this exercise. 

Object Data Search Fields 

A number of pre-defined object data fields are provided with the GIS reference data source drawings 
for CAD users. 

It should be noted that these fields are provided to allow the location of a general geographic area 
of Cadastral data needed for design work. 

This includes some transformer data, and customer NMI data. 

We should understand that searching for and locating a transformer and / or NMI is to simply locate 
Cadastral data adjacent to these asset items, and not to extract or manager data associated with 
transformer and / or NMI assets. 

These fields are provided as Object Data available within the source drawings, which may be terms 
“Smart AutoCAD Drawings”. They are “Smart AutoCAD Drawings” as they contain Object Data fields 
associated with each CAD Object. 

The following the major fields which are available as Object Data, and therefore searchable: 

Field Description Table Name Object Data Field Name 

 House Number ACAD_PROPERTY HOUSE_NUMBER 

 Street Name ACAD_PROPERTY STREET_NAME 

 Suburb Name ACAD_PROPERTY SUBURB 
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Field Description Table Name Object Data Field Name 

 Feeder ID ACAD_TRANSFORMER FEEDER_ID 

 Transformer ID ACAD_TRANSFORMER TRANSFORMER_ID 

 Customer NMI ACAD_NMI NMI 

 Plan & Parcel ACAD_PARCEL PLAN_NUMBER, PARCEL_NUMBER 
 

Note: A complete listing of all Object Data fields and Data tables is described in Section 15 at the end of this 
training guide under the title of “GIS Cadastral Data Fields”. 

Locating Cadastral Data via Transformer and NMI Search 

Cadastral Data may need to be located in relation to the location of a Transformer and Customer 
NMI number. 

The method of locating Cadastral data using the location of a Transformer and / or NMI number is 
different from that used to located addressed properties etc. 

The methods discussed here will be only one of a number of methods to use Transformer and NMI 
data, and can be used in many combinations of options. 

The method we will discuss here will be to locate an individual transformer, and then an individual 
NMI, and then review the addressed property data that exists within the vicinity of both locations. 

The process for locating this addressed property Cadastral data would be generally as follows: 

 Query and locate the required Transformer 
 Query and locate the required NMI 
 Zoom both of these onto the screen 
 Query and locate Addressed Property data with a window including both of the above locations 
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Exercise: Locating Addressed Property Data 

Let’s perform an exercise related to project 100628702, within the suburb of Blakeview 

The objective of this exercise will be to locate the addressed property data and within the vicinity of 
the following 2 objects: 

Transformer & NMI Info: 
 

 

 

 

1. Create a new Drawing and save as follows: C:\CAD-Vault-LD\100628702\LD-100628702-AW-03-
Transformer-NMI-Locate.dwg 

 

2. Attach the “LB-Transformer-NMI-Elizabeth-MGA-54.dwg” as the source drawing for the Query to be 
performed within. 

 

At this point the Map Explorer Task Pane should appear similar to the illustration below: 

 

 

  

Transformer ID 90 

Feeder ID EL13 

NMI # 20017011824 
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We will now run our Query of attached Drawings on this Transformer and NMI source drawing. 

1. Select Data > Query Source Drawing … and then select the Data … button. 
 

This will activate the Data Condition dialog box, as shown below: 

 

Because both the Transformer and NMI data is actually “Point” data within the source drawing, we 
will search for this data differently than we did for an addressed property. 

2. Select the Attribute option, and then locate the following Block name: ACMAP_ANN_TEMPLATE_LB-
Trans-No-Feeder-No-Text 

 

The selection of the Block name within the Data Condition dialog box should appear similar to that 
shown below: 
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3. Select the LB-Trans-No-Text attribute tag and enter a value of 90, and then select OK 
 

4. Select the Data … button again, select the Attribute option, and then locate the same Block name: 
ACMAP_ANN_TEMPLATE_LB-Trans-No-Feeder-No-Text 

 

5. This time we will select the LB-Feeder-No-Text attribute tag and enter a value of EL13, and then select 
OK. 
 

6. We should then select the Execute Query button, which should locate the above transformer, and 
display the point and label within our drawing. 

 

Exercise: Locating a Customer NMI 

We will now proceed to locate a customer NMI 

1. Select Data > Query Source Drawing … and then clear the previous query using the Clear Query 
button. 

2. Now we can go ahead and select the Data … button which will activate the Data Condition dialog box, 
and we can select the Attribute option, and then locate the following Block name: 
ACMAP_ANN_TEMPLATE_LB-NMI-Number-Text 
 

The selection of the Block name within the Data Condition dialog box should appear similar to that 
shown below: 

 

 

3. Select the NMI attribute tag, and enter a value of 20017011824, and then select OK 
 

4. We should then select the Execute Query button, which should locate the above customer NMI 
location, and display the point and label within our drawing. 
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The results of the query should indicate that the software has actually located 2 objects as shown in 
the command line illustrated below: 

 

We had two objects located as there is the point, and the label for the point. 

5. If we perform a Zoom Extents both the transformer and NMI should display on the drawing, locating 
the correct coordinate area in MGA-54 of these objects. 
 

6. Having now located these 2 objects, we can Detach the current source drawing, and attach the 
addressed property drawing, to obtain adjacent data to these points. 
 

7. Detach the LB-Transformer-NMI-Elizabeth-MGA-54.dwg and then attach the LB-Addressed-Property-
Elizabeth-MGA-54.dwg. 

 

8. Zoom the drawing so that the transformer and NMI are located similar to the illustration below: 
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Road Name Display in AutoCAD 

The management of the display of Road Names has always presented a challenge, as Road Names by 
default will appear adjacent to the centre of a roadway. 

If the names are provided as vector geometry, and translate through to the current CAD drawing as 
text objects, they will invariably be displayed at incorrect angles, and locations. 

The design corridor for most line design projects for example is within the road reserve area of 
Cadastral data, where it would be most common to display road names. 

This means that drawing space for Road names, and location of Road names on a drawing can be 
challenging. 

The solution for the display of Road names in the GIS reference data sets, aims to address some of 
the above issues, and make this workable for the CAD users. 

Process for Placing Road Name Labels 

The general process for adding Road names to drawings is as follows: 

 Add the Road Centreline Geometry to the drawing 
 Add Road names with the custom text routine 

 

Exercise: Placing Road Name Labels 

The objective of this exercise is to run through the above process on a small project drawing, to 
understand the process and concepts. 

1. Firstly ensure AutoCAD is launched, and then open the following drawing: 
 

 C:\CAD-Vault-LD\100628702\LD-100628702-AW-03-Road-Name-Labels.dwg 

This will retrieve a drawing with a small amount of Cadastral addressed property data ready for us to 
apply some basic Road name labels as text objects. 

2. When the drawing is opened it should appear similar to the illustration below: 
 

Non-Cadastral Reference Data 

There is a need during the design process for access to what we will call reference data other than 
GIS cadastral data, to complete our design work. 

Non-Cadastral Reference Data Types 

As CAD users we now have the ability to access and import the following data types into project 
drawings: 
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 Bush Fire Risk Areas 
 CFS Fire Ban Districts 
 Environmental Control Areas 
 Phytophthora 
 Footrot Areas 
 Broomrape Areas 
 Needlegrass Areas 
 Contaminated Sites 
 SA Power Networks Fibre Network 
 SA Power Networks Pilot Cable Network 
 ENSA Transmission Data 
 SEAGas Pipeline Data  
 Railway Data 
 Water Body Topo Data 
 Water Source Feature Topo Data 
 Water Course Topo Data 
 Water Pipeline Data 

 
This reference data is provided in native CAD format as a series of source drawings to avoid the 
requirement to trace or estimate where this geometry is located in relation to other Cadastral or 
project design geometry. 

The data can be saved within our project drawing files, and provide additional documentation 
indicating the available data sources at the time the design project was completed. 

Capturing this reference data within the project drawings provides additional project quality 
assurance and gives the exact location of the reference data as it was at the time the design was 
completed and documented within the drawing. 
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Demonstrate “EXTRIM” 

Dynamic Coordinate Display 

The requirement for the dynamic display of geographic coordinates so that the location of any 
object, is provided by a Map Tracking Coordinate display system with the AutoCAD Map software. 

When the AutoCAD Map “maptrackcs” option is enabled a display similar to that shown below is 
available to the user: 

 

 

 

Additional Coordinate Display Advantages 

This coordinate display function also provides some additional advantages as follows: 

 This can be used to identify the easting and northing values of the project geographical area 
 The display of the easting and northing coordinates can be done in a coordinate system that 

is different to the coordinate system of the current drawing. For example the current 
Drawing may have a coordinate system of MGA-54, and the display of coordinates can be set 
to LL-GDA94 

 It is also possible to directly input an easting and northing value into a Drawing using this 
interface. For example if the CAD user knows the easting and northing coordinate values of 
existing pole positions, an AutoCAD Block symbol for an existing Stobie Pole can be inserted 
using these values. 
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Storing AutoCAD Map 3D Drawings in Autodesk Vault 

The Autodesk Vault Drawing repository provides secure database access to Drawing files, which will 
be stored within the Vault ADMS Server system. The Vault ADMS Server system is based on a 
Microsoft SQL Server Database system, where each Drawing is indexed within this Database, and 
references to the actual drawing file are maintained. The Drawing files are stored and encrypted 
within the File Store which is unique to the individual Vault Database. 

The following illustration gives an overview of the Vault systems, showing the Server system on the 
left, with Client systems in the right: 

 

A Vault Database comprises the following 2 components: 

1. A Microsoft SQL Database 
2. A File Store folder area unique to that Database 

 

For the Line Design Vault Repository a separate Database and File Store area is provided with 
encryption of the native Drawing files so that users cannot access them, without the appropriate 
Client software. 

Background Business Drivers for Vault 

A requirement was identified to provide a Vault Drawing repository system for the storage and 
secure access of AutoCAD Drawing files. 

The Vault Drawing repository is designed to provide the following general features to the business as 
a whole: 
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Key User Benefits: 

 Ensure best CAD performance for Drawing file Opening, editing and Saving 
 Version Control and history of Drawing changes 
 CAD File relationship management for ease of access by all 
 Unique Drawing Filename Enforcement to eliminate file duplication 
 Project Folders to assist with file management practices 
 Searchable Drawing Title Block Attributes for Fast access to Drawing files 
 File Security for Work-In-Progress Drawing Editing for transparency and collaboration 
 Provide a Search Tool to locate files, for information and editing of drawings 
 Replace the “Master Outbox” system for Caddsman 

 

Other Vault Benefits: 

 Minimise IT network traffic where possible 
 Minimal Network Dependency for best CAD user performance 
 Access to the Vault from within AutoCAD 
 Automatic Publishing of Drawing Viewable Files for Non-CAD Users (*.Dwf) 
 Off-Line Access to Drawing Files for Mobile users off the corporate network 
 Effective Control of all AutoCAD Project Drawings via Secure Database Access 

 

Currently Network project officers (NPO), and other CAD design staff who use the Caddsman 
software utilise various areas of the enterprise R: drive folders to store data for use in designs 
projects. 

This method is not Best Practice with AutoCAD, and does not keep drawing data files under effective 
management and control. 
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Vault Explorer Toolbar Commands 

The following table shows the functions of the Toolbar buttons within the Vault Explorer interface: 

Vault Explorer Icon Function Description 

 
New Folder Creates new folders, and will be used for creating folders 

for new NPO projects 

 

Refresh Updates the display of the status information for Vault 
files in the main table 

 

Print direct Prints the main table grid display 

 

Print preview Provides a print preview function of the print direct from 
the main table above 

 

Delete Deletes a drawing file 
Note: Must be used with caution, as there is no undo function 
for this delete command 

 

Attachments This function allows drawing dependencies or 
attachments to be created and removed 

 

Add Files This is the key way of adding non-AutoCAD Drawing files 
to the Vault 
Files such as .txt, or .xls, .xlsx, .jpg etc 
All AutoCAD Drawing files should be added from within 
AutoCAD itself 

 
Copy Design Performs a smart Save-As function within Vault to save a 

Drawing and it’s attachments to a new name 

 
Check In Allows the latest edited version of a file to be updated in 

the vault database 
This should only be done within AutoCAD for .dwg files 

 
Get / Check Out There is two functions associated with this: 

1. Get Latest 
This is the default setting, and retrieves a Read-
Only version of the file from the Vault database 
to your local C drive 

2. Check Out 
This reserves and locks the file within the Vault 
and makes it Read-Write for the user as well as 
and retrieving a version of the file from the Vault 
database to your local C 

 

Undo Check Out This function releases the reserve or lock on a file, and 
makes it available for other users to Check Out and hence 
to edit a file 
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Vault Explorer Icon Function Description 

 
Find This function is the Search capability of Vault, which is 

available as a Simple or a Complex search 

Vault Project Folders for Line Design 

To keep projects organised within the Vault database for Line design, folders will be created for the 
storage of Drawing files and other CAD related files. 

The Line Design Vault will provide a top-level folder structure under which all Line Design projects 
will be filed. 

The project folders will be named within Vault according to the SAP NOTI number for the project. 

These folders will appear within the Vault repository similar to the illustration below: 

 

 

 

Folders can be created by any user but will be visible to all users of the Line Design Vault, across all 
asset manager areas. 

The Vault project folders will have a corresponding local working folder on your local C drive, when 
files are retrieved from Vault via the Get Latest or the Check Out functions. 

The CAD-Vault-LD Database has a fixed top-level folder path for its local Vault Working folder which 
is: C:\CAD-Vault-LD 
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Files within the folder that have been added to the Vault will have their status synchronised with the 
Vault Database. 
 
This is the local C drive working area for all editing functions within AutoCAD, and all AutoCAD 
Drawings must be maintained under effective control within this folder structure. 

Exercise: Creating Project Folders – Vault Database & Local 

In this exercise we create a new project folder, and ensure we see this created on our local C drive, 
to allow drawing files to be created within that folder. 

When creating a new AutoCAD Drawing, it is Best Practice to create the Drawing initially within the 
correct folder structure in which it will reside within Vault. 

Best 
Practice 

Creating new Drawing Files 

 

When creating a new AutoCAD Drawing, it is Best Practice to create the Drawing initially 
within the correct folder structure in which it will reside within Vault 

 

One way of ensuring this happens is to follow the practice below: 

1. Create new Drawing Project Folder in Vault 
2. Browse to that folder in the Vault database 
3. Right Click on the Folder name and select “Go-to-Working-Folder” 
4. Create the new Drawing in AutoCAD 
5. Save the Drawing in this new local Working Folder 
6. Check In the Drawing to Vault 

 

Let’s begin this process: 

1) Browse to the top-level “Vault Explorer ($)” folder 
2) Right-Click and select New Folder 

When naming the folder we will use a combination of an example NOTI number and user name. 

3) Call the folder “100610499-willj3” but replace the “willj3” with your username. 

 

You created this PDF from an application that is not licensed to print to novaPDF printer (http://www.novapdf.com)

http://www.novapdf.com


Autodesk University 2014       

GS5606 AutoCAD Map GIS Source Drawings and Vault Page 33 of 53 
 

 

In the above case the folder should appear within the Vault as shown below: 

 

 

The folder has now been created in the database but not locally on the C drive of our PC 

To create the folder locally on the C drive of our PC: 

1) Select the folder, right-click and select Go to Working Folder as shown below: 
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This will open a Windows Explorer window, which on a Windows 7 system will appear similar to the 
illustration below: 

 

 

 

AutoCAD drawing files can now be saved directly into this folder before being added to the Vault 
with a Check-In process. 

Sample Exercise: Creating new Drawing Files – Vault Add-In for AutoCAD 

In this exercise we will create a new project folder, and ensure we see this created on our local C 
drive, to allow drawing files to be created within that folder. 

We will then create a new AutoCAD Drawing file, save this file into the appropriate folder and Check 
In this file into the Vault. 

Let’s begin: 

1) Launch AutoCAD with the AutoCAD Map 3D 2011 desktop icon: 
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2) Ensure you are working in the Line Design AutoCAD Profile by selecting: 

“SAPN Tools > Set Profiles > Line design Profile” 

 

3) Create a new Drawing using the Line Design Template as follows: 
 
a) Select File > New > select the LD-Template.dwt file and click Open in the dialog box, as shown below: 

 

We will now save this Drawing file directly into the project folder we have just created. 

1) Select File > Save As and browse to the “C:\CAD-Vault-LD\100610499-willj3” folder created above. 

Note: Your username will be applied to this folder as above. 

2) Select the File name: area of the Save Drawing As dialog box, and name the Drawing 
as follows: LD-100610499-AW-willj3 -  replace the “willj3” with your own Login name 
 

Note: We are using a username suffix on the drawing files in this exercise to keep the filenames 
unique within our training Vault system. 

In production all Line Design drawing file names will need to comply with the naming convention 
documented below. 

 

You created this PDF from an application that is not licensed to print to novaPDF printer (http://www.novapdf.com)

http://www.novapdf.com


Autodesk University 2014       

GS5606 AutoCAD Map GIS Source Drawings and Vault Page 36 of 53 
 

We will now open a local Windows Explorer browser and verify that the file has been created in the 
correct location. 

2) Open a local Windows Explorer browser by holding down the “Windows” key on the keyboard and 
selecting the “E” key as shown in the illustration below: 
 

 

Note: This combination will always open a local Windows Explorer browser, as opposed to a Web-Desktop 
explorer window. 

3) Browse to the “C:\CAD-Vault-LD\100610499-willj3” folder. 

The window should appear similar to that shown below: 

 

 
We will now Check In the file, so that it’s correctly secure in the Vault database through the 
AutoCAD Vault Add-in. 
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1) Go to the AutoCAD select the “Vault” ribbon, as shown below: 
 

 

Note: Logging into Vault within AutoCAD is completely separate from the Vault explorer Login. 

2) Login to the Vault using the Log In button on the AutoCAD Vault ribbon as shown below: 

 

The Log In dialog box will appear similar to that shown below: 

  

3) Login with your username and welcome password. 

AutoCAD is now connected to and synchronised with the main Vault Database. 

When Login has been successful the Check In button on the ribbon will become active. 

4) Select the Check In button and in the section at the bottom of the Check In dialog box enter the following 
comment: “Initial Check In for training” 
 

5) Select OK and wait a few moments for the Check In process to complete. 
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The Check In process should be complete when a message similar to that shown below is displayed: 

 

 

6) We should now go back to our Vault Explorer window, select the folder we have created, and perform a 
Refresh function with the following button: 

 

We should then see our newly created AutoCAD drawing as a .dwg file appear in the correct project 
folder, similar to the illustration below: 

 

 
 

File Naming Conventions – Drawings & Associated Files 

With the implementation of a good drawing control system, where we share data easily, comes the 
need for consistent and common standards in the naming of our files. 

This benefits the Customer Solutions group, the Facilities records group, and other support groups 
who use the files created and stored within the Line Design Vault. 

With the new AutoCAD Map drawing system, came the implementation of the Vault Drawing 
repository for safety security and easy access to our Drawings. 

This guide is intended to provide a ready reference for the agreed and approved file naming 
convention to be used for all Line Design Drawings. 
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AutoCAD Drawing Filename Convention 

The file naming convention for the AutoCAD Line Design project Drawings will be based on the 
applicable SAP NOTI number, and also include a Drawing type code. 

For example, a typical small project Drawing may be named: LD-100652841-AW.Dwg 

The components of the name are: 

LD Designates that the drawing is a Line Design drawing and built from the Line Design 
CAD file template, named “LD-Template.dwt”. 

100652841 Is the NOTI number from SAP. 

AW  Is the Drawing type code, which may be AW, QS, CS or DD 

The following Drawing type codes may apply: 

 AW – Asset Work 
 QS – Quality of Supply 
 CS – Customer Supply 
 DD – Distribution Defect 

 

Additional Drawing Sheet Information 

For minor jobs, generally done by CSOs but not exclusively, only a SAP notification is raised. 

For larger jobs a ‘Project definition’ number is also raised. This is referenced back to the SAP 
notification and is used to monitor projects including milestones and financial reporting. Project 
numbers have in the past been CP, NW, EX etc. 

As part of the NECF Process we now have a common NC Project (combining CP, EX and URD) which 
required us to separately identify the different types of projects for reporting. 

The list below allows you to choose the project type for inclusion on the drawing sheet. 

New ‘Project type’ descriptors: 

 RC – Retail Customer (Customer connect projects) 
 RD – Real Estate Development (URD UID) 
 EG – Embedded Generation 
 AR – Asset Relocation (old EX jobs) 
 PLEC – Powerline Environment Committee 
 Q of S – Quality of Supply 
 TC – Telecommunications 
 NW -  Network Upgrade Projects 
 NBN – NBN Projects 
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So for the  majority of NPO type projects, the drawing sheet will include a Project number, NC-
000000; a Project type, RC; and a Notification type, CS.  This will allow us to search for drawings 
within the Vault, based on project number, type and notification type. 

Drawing File Names - Single Sheet Drawings 

The standard file naming format for single sheet drawings will be as follows: 

LD-1006####-CS.dwg   

By not adding a ‘-01’ on single sheets, viewers can quickly identify if multiple sheets are involved.   

Note: 

We do not add a revision number to the drawing name, as this is captured and searchable as a 
separate field in the Vault Database. 

Drawing File Names - Multiple Sheet Drawings 

For multiple sheet drawings, the following file naming conventions will be used: 

 
Standard CSO, NSO or NPO drawings 

For multiple sheet drawings that will be: 

 Only worked on by one person at a time; 
 and all sheets will be revised in unison 
  

All sheets will be contained within a single drawing file using multiple layout tabs. 

 

The standard file naming format for these drawings will be as follows: 

LD-1006####-CS.dwg 

 
Strategic Project or major project drawings 

For multiple sheet drawings that may be: 

 Worked on by multiple people at any one time; 
 or sheets may be revised individually 
 Each sheet will be contained within a single drawing file with a single layout tab. 

 

The standard file naming format for these drawings will be as follows: 

LD-1006####-CS-01.dwg 
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LD-1006####-CS-02.dwg 

LD-1006####-CS-03.dwg 

The above arrangements will provide the simplest file naming convention, while allowing for the 
future implementation of Vault Professional revision tracking and approval functions. 

 
Note: 

 Where multiple AutoCAD Drawing files exist for larger projects they will all be stored within the same 
folder, named according to the applicable NOTI number. 

 Files can be Renamed within the Vault Drawing repository to allow for some project flexibility 

 This rename function is however an “Editor Level 2” function 

TIF & PDF File Naming Convention 

The file naming convention for TIF and PDF files created from AutoCAD Drawings and added to the 
Vault, will be based on the drawing name, with the addition of a revision letter at the end of the file 
name. 

Single sheet example: 

LD-1006####-CS-A.tif or 

LD-1006####-CS-A.pdf 

Multiple sheet example: 

LD-1006####-CS-01-A.tif or 

LD-1006####-CS-01-A.pdf 

Site Photograph Image File Naming Convention 

The file naming convention for site photographs, maps etc that are added to AutoCAD Drawings 
from within the Vault, will be based on the drawing name, with the last two numbers being a simple 
numerical list of image files used for this project, for example: 

First photo image used: 

LD-1006####-01.jpg 

Second photo image used: 

LD-1006####-02.jpg etc 
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Excel Spreadsheet File Naming Convention 

The file naming convention for Excel Spreadsheets that are used in AutoCAD Drawings from within 
the Vault, will be based on the drawing name, with the last two numbers being a simple numerical 
list of files used for this project, for example: 

Pole schedule example: 

LD-1006####-PS-01.xlsx 

Stringing chart example: 

LD-1006####-SC-01.xlsx 

Bore Log example: 

LD-1006####-BL-01.xlsx 

Drawing Filename Prefixes – Other SA Power Networks Groups 

There will be a number of different SA Power Networks groups using AutoCAD based software, and 
creating drawings from different AutoCAD template files. 

The following groups will be using the following drawing filename prefixes: 

Drawing 
Filename Prefix 

SA Power Networks -  CAD Group 

LD- Line Design Group – AutoCAD Map “LD-Template.dwt” 

GN- General Drafting – Common to all - AutoCAD Map “GN-Template.dwt” 

FR- Facilities Records Group - AutoCAD Map “FR-Template.dwt” 

PL- Public Lighting Group - AutoCAD Map “PL-Template.dwt” 

SV- Survey Group - AutoCAD Civil3D “SV-Template.dwt” 
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Unique Filenames in Vault 

All files within the Vault database for Line Design will have unique names. 

This means that once a file has been added to the Vault, no other file may be added of the same 
name. 

For example: 

If “LD-100652841-AW.Dwg” is already in the Vault, no other file named “LD-100652841-AW.Dwg” 
can be added to any other folder of the Vault. 

However “LD-100652841-AW.TIF” or “LD-100652841-AW.PDF” could be added to the Vault, as they 
do have a different file extension to the .Dwg file. 

The Vault will have a unique filename enforcement policy, to enforce the above, so that there is only 
1 master file of each name, and the latest file location is clearly know to all. 

Working with Vault and AutoCAD 

The information in this section is focussed on work done directly within the AutoCAD software, and 
how this interacts with the Vault database. 

Drawing Check Out and Editing Functions 

We will now review the editing functions that are performed within AutoCAD and the process of 
Checking Out the Drawing we have just created so further editing can be performed on the Drawing. 

During the edits we will remove a number of Sheets (Layouts) from this Drawing, and use only an A3 
landscape Sheet. 
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Exercise: Drawing Check Out and Editing 

In this exercise we will access the newly Vaulted drawing from within the Vault ribbon interface in 
AutoCAD, to see the interaction between AutoCAD and Vault. 

IMPORTANT NOTE: 

Before commencing the exercise below, please ensure the drawing previously used has been closed 
without saving, checking out etc. 

1) Activate the AutoCAD window, and select the Vault ribbon. 
 

2) Confirm that you are Logged into Vault. 
 

If you are not Logged into Vault the Login In button will appear available, as shown below: 

 

During Login a confirmation message will appear within the AutoCAD command prompt area, similar 
to that shown below: 

 

 

We can confirm the connection status of AutoCAD to the Vault database by Checking the small Vault 
Icon in the Drawing Status bar at the bottom right corner of the AutoCAD window. 

The Vault status Icon appears similar to  button. 

3) Hover over the button with your cursor, you should see your connection status similar to that shown 
below: 
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If you are Logged into Vault the Login Out button will appear available, as shown below: 

 

 

4) Within the AutoCAD Vault ribbon, select the Open button as shown below: 

  

This will force AutoCAD to browse the Vault database for Drawing files, rather than your local 
Windows drive. 

 

5) Navigate the folders to your project folder, in a similar manner to the illustration below: 
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6) Select the Drawing file, and select Open on the dialog box as shown below: 
 

 

A prompt should now appear indicating that the Drawing is not currently Checked Out to you as a 
Vault user, and do you want to Check it Out now? 

 

 

7) Select Yes on the dialog box above, to make the drawing file Read/Write on our local PC so we are able to 
edit. 

In performing the Check Out function on this Drawing we have reserved it for editing only by 
ourselves, and locked this file in the central Vault database. 

8) Open your Vault Explorer window and select the Refresh button to see the new Checked Out status of the 
file. 
 

The Status of the Drawing should now change, showing a  mark as the drawing status icon. 

This should appear similar to the illustration below: 
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We will track the status changes as we proceed with our editing session in AutoCAD. 

We will now edit this drawing to remove the unwanted drawing sheets, leaving only the A3 sheet. 

1) Go to the Layout Tabs at the bottom of the AutoCAD drawing area which show the Model and all other 
Sheet Layouts: 

 

 

 

2) To remove unwanted sheets firstly activate the “A0” sheet as shown  and then holding the CTRL 

key down, select the other sheets, not needed  being 
cautious not to select the A3 sheet we wish to keep. 

 

3) When the Layout sheets are selected, right-click over one of the Layout Tabs and select Delete from the 
menu, in the similar manner to the illustration below: 
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A warning window will appear as shown below: 

 

 

4) Simply select OK to proceed. 

 

The final display of the Model and Layout tabs should appear as shown below: 

 

Best 
Practice 

Remove Un-Used Drawing Sheets from Paper Space 

 

It is Best Practice to remove any un-used drawing sheets from the Drawing Paper Space area 
for the following reasons: 
 

 Drawing file size will be more compact if un-used sheets are removed 
 This reduces the Previews generated for each sheet on Check-In 
 Drawing Title Block attribute mapping is controlled correctly 

 

 

Exercise: Checking In 

We will now Check In the drawing, to see if changes have occurred within Vault. 

1) If you select the Vault ribbon within AutoCAD, you should now see the Check In button available to use, as 
shown below: 

   

2) Select the Check In button to secure the drawing changes into the Vault database. 
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The Check In dialog box should now appear similar to the illustration below: 

 

3) Enter the comment as above Removed Layout Sheets from Drawing 

As we have not yet actually saved the drawing file since our edits, AutoCAD will prompt us to save it 
to our local drive before continuing with the Check In process. 

 

 

4) Select Yes in the dialog box above: 
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Best 
Practice 

Exercise Caution with “Check In Comments” 

 

It is Best Practice to enter comments in the Check In dialog box, which are meaningful to the 
current status of the drawing development. 
For example if Land Base data has just been imported, you may wish to record a comment / 
remark saying “Land Base data imported” or “Reference Data for Bush Fire Risk area added”. 
 
Check In remarks are visible and searchable within the Vault database, and cannot be edited. 

 

5) Within the Vault Explorer window, select the Drawing file, and note that we have a new Version of the 
drawing file, with the comment of Removed Layout Sheets from Drawing. 
 

6) If we view the Preview Tab, we will now see that we only have 1 of 1 sheets, which simplifies the display. 
 
The Preview Tab within Vault Explorer should appear similar to the illustration below: 

 

We should also note that previous visualisation files are displayed in the Preview Tab, by selecting an 
earlier Version number from the Pull Down list on the left of the preview window: 

 

In the case of our Drawing, Version 1 shows 10 sheets. 

Note the warning associated with this visualisation file: 

“Warning: This visualisation file displayed is not the most current version” 

This is simply because we now have a later version of the file, which is why when we select Latest 
version, the message is not displayed. 
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Appendix: 
Sample Data Sets 

The sample data sets used in the training exercises previously are available for download 
from the file named “”CAD-Source-Drawings.zip”. This file is 138Mb in size. 

following table contains a list of terms, acronyms and their definitions used in this document: 

Definitions, Acronyms and Abbreviations 

The following table contains a list of terms, acronyms and their definitions used in this 
document: 

Term Definition 
AutoCAD A CAD (Computer Aided Design/Drafting) software application for 

2D and 3D design and drafting, developed and sold by Autodesk, 
Inc. 

CAD Computer Aided Drafting 

Conversion The “on demand” process to convert  drawings from CADDSMAN to 
AutoCAD on an as needs basis. 

SAPN SA Power Networks 

GIS Geographic Information system 

Migration The process to migrate, in bulk, CADDSMAN drawings to the 
AutoCAD format 

NMT Network Management Team 

NPO Network Project Officer 

PLS CADD Power Line Systems – Computer Aided Design and Drafting.  
Software for the structural and geometrical design of overhead 
power lines 

Schema File A file which defines the interface between two systems (.xml) 

Switching Diagram CAD based drawing indicating High Voltage Distribution Network for 
operational purposes 

TOPAS Powerline design software integrated into and dependant on 
CADDSMAN to operate 

AutoCAD .Dwg file This is the standard native format of AutoCAD Drawing files, which 
has become a global CAD 2D Industry standard 

Smart AutoCAD 
.Dwg file 

This is an enhanced AutoCAD Drawing format file which includes 
additional Object Data applicable to the Mapping / Civil 
Engineering and Surveying fields 
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Object Data Object Data is CAD based metadata about a CAD object. It is 
attached to the CAD Object in a non-geometric format. For 
example a Road may appear as Line geometry, but the name of a 
Road is attached to it as Object Data 

Shape File This is an ESRI Geospatial Data exchange format which can be read 
by and written to by the AutoCAD Map software. Shape file data is 
usually provided as a set of data files 

SDF File This is an Autodesk format of Geospatial file capturing both 
Geometry and Object data in one compact file format 

ECW File This is an “Enhanced Compression Wavelet” graphical image format 
optimized for aerial and satellite imagery, and proposed for use as 
Topographical map files for reference data 

Reference Data This is data used to assist CAD designers in locating other objects and 
geometry that relate to the current design. This may be a “Bush Fire 
Risk Area” or “Environmental Control Area” or existing SA Power 
Networks Fibre Network location 

Georeferencing The ability to define the location of assets “Poles” or “Transformers” 
etc in physical space. To correctly Georeference an object’s 
location is to establish its location in terms of a map projection or 
coordinate systems 

CAD Layer This is a feature of a CAD System to place CAD Geometry such as 
Lines of Text on a Layer, and have the visibility of all Objects on this 
Layer On or Off by changing the state of the Layer to On or Off 

Map Layer This is a feature of the AutoCAD Map software to reference non-CAD 
Geometry such as an ESRI Shape file, SDF file, or ECW file into a Map 
Drawing and have the ability to change the visibility of all Objects on 
this Layer On or Off by changing the state of the Layer to On or Off 

Data Translation This is the process of converting the format of a data file from one 
format to another, to import or export data from the CAD system. For 
example ERSI Shape file data may be converted or translated into 
AutoCAD .Dwg file data and vice-versa. This practice should be kept 
to a minimum for productivity and data consistency reasons 

TOPO Data This is an acronym for Topographic Data which is essentially a 
detailed and accurate graphic map representing cultural and 
natural features on the ground. Topo data will be provided to 
AutoCAD users in ECW format 
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Map Sheets A tiled grid of map sheet references corresponding to the 
geographic polygon shapes of map numbers and sheet references 
at scales of 1:100,000 and 1:250,000. These are defined and 
maintained by Geoscience Australia, who describe this data set as 
follows: 
“These are separate GIS data of map numbers and map names 
appearing on NATMAP 1:100 000 and 1:250 000 scale topographic 
maps and GEODATA TOPO 250K Series 2 data tiles. The datasets 
contain map numbers, map names and the geographic extent of 
each map and data tile in the index of map sheets” 

Oracle Spatial 
INTFIN Database 

A master of GIS Land Base Data sourced from the DENH Land 
Services Group is contained within the Oracle Spatial “INTFIN” 
Database. This also contains data which has been processed by the 
SA Power Networks GIS group, to cleanse geometry issues, and 
enrich the metadata for downstream business applications within SA 
Power Networks 

Customer NMI A customer NMI is a National Meter Identifier. This is a unique number 
used nationally by electricity suppliers to identify the electricity meter 
at customer properties. This is included as a location identifier for 
searching and finding a geographical location 
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